MICROSOFT EXCEL FOR INTERMEDIATE LEVEL

Note: Your Excel screen may look different from the images in this guide if you have a different version or setting than the guide. However, most
content should be similar.

Golden West College Office of Research, Planning, and Institutional Effectiveness
Email: research@gwc.cccd.edu
Website: http://research.gwchb.net

After successful completion of this training, participants can expect to have learned these skills:
e Edit worksheet view for ease of data visualization and prepare worksheet for printing via the View Tab
e Organize data for easy managing and analyzing
e Understanding of Text Functions (LEFT, RIGHT, LEN, etc.)
e Understanding of VLOOKUP and INDEX MATCH
e (Create, modify and customize PivotTables
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View Tab — edit worksheet view
View tab has features to change the view of worksheets and make it easy to view data. This tab is also used to prepare workbook for printing.
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Figure 1. View Tab in Excel
Groups under the View tab:

1. Workbook Views contains 4 types of workbook views — Normal, Page break preview, Page layout & Custom Views.
e Normal option to see the default view of a worksheet.
e Page Break Preview option to see that where the page-breaks appear when the document is printed.
e Page Layout option is used to view where the page-breaks appear as well as any header/footer on the page.
e Custom View option to save the current display and setting as a custom view which we can apply in future.

2. Show group is used to show or hide the ruler, gridline, formula bar, or headings.
o Ruler, only available in Page Layout view, is used to show the rulers next to the worksheet.
e Gridlines option is used to show/hide the lines between rows and columns in the worksheet
e Formula bar option is used to show/hide the formula bar.
e Heading option is used to show/hide the heading of columns and row numbers.

3. Zoom group is used to adjust the view in a workbook.

4. Window group is used this option to access the window options.

o New Window is used to open the same document in the new window, and we can perform in the both windows and thus both documents
will get updated.

e Arrange All option helps stack all opened Excel workbooks so that all workbooks are visible at once.

o Freeze Panes option keeps selected rows and columns visible while scrolling through the rest of the worksheet and includes Freeze Panes,
Freeze Top Row, and Freeze First Column.

e Split option is used to divide the window into different panes at the active cell such that each scrolls separately.

o Hide option is used to hide the current workbook. Click Unhide to unhide workbook.

5. Macros option allows you to record and view the macro.
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Organizing Data
Brief overview of how ways organize and format data.
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Figure 2. Data organizing options in Excel

We are going to touch of parts of the features in the Data tabs; Sort & Filter group and part of the Data Tools group.

Sort & Filter group allows data to be sorted and filtered.

e Sort & Filter allows you to sort data alphabetically, numerically, and in many other ways. Select the column or range you want to sort, then
select Ato Zicon to sort in ascending order, Z to A icon to sort in descending order click Sort to customize sort options.
o Filter adds a filter header to selected columns and allows you to view specific data in a worksheet, while hiding the other rows, by

selecting the desired data to view.

Data Tools group include tools for data manipulation.

e Text to Columns allows for information that appears in one column to be converted into multiple columns, which can be easier than

retyping the data or writing a function.

o Flash Fill is automatically apply when Excel establishes a pattern in the data you are entering. To manually activate Flash Fill, fill in the first

cell and press Enter. Click the Flash Fill button.

o Remove Duplicates allows the deletion of duplicate values based on selected criteria.

Text Functions

Text functions allows for the manipulation of data in text forms.
o Left() is used to extract the leftmost characters from a string. Syntax =left(text, num_char)
e Right() is used to extract the rightmost characters from a string. Syntax =right(text, num_char)
e Len() identifies the length of a text string including spaces. Syntax =LEN(text)

e Mid() is used to extract the characters from the middle of a string. Syntax =MID(text, start_char, num_chars)
e Find () is used when you want to know the position of certain characters in a particular string. Syntax =FIND(find_text,

within_text,[start_num])
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VLOOKUP is a function used for lookup and reference. It looks for the desired values from one row to another to find a match.
Syntax =VLOOKUP(value, table_array, col_index,[range_lookup]).

INDEX MATCH is a function used for lookup and reference, similar to VLOOKUK. INDEX returns the value of a cell in a table based on the column
and row number. MATCH returns the position of a cell in a row or column. Combining these two functions we can look up a value both horizontally
and vertically.

Syntax =INDEX(range, MATCH(lookup_value, lookup_range, match_type))

Why VLOOKUP or INDEX MATCH
Use VLOOKUP for:
e relatively small data
e |ookup values not to exceed 255 characters in length
lookup value is in the first column. VLOOKUP cannot look to its left
first column is sorted alphabetically. If your table is not sorted that way, VLOOKUP will return the first closest match
e data in which columns will not be inserted/deleted
e static reference. Therefore, adding a new column to the table breaks the VLOOKUP formula

Use INDEX MATCH when:
e Dynamic column reference, columns can be deleted or added without distorting the array
e Higher processing speed compared to VLOOKUP for large data sets
e Performs lookup both horizontally and vertically

VLOOKUP is a very effective lookup and reference function when you have a small data set and are not affected by the limitations of the function.
Otherwise, use INDEX MATCH.

A PivotTable is a tool to calculate, summarize, and analyze data that lets you see comparisons, patterns, and trends in your data. This guide gives
you a quick overview of creating a pivot table. For a more detailed tutorial, please search the internet for tutorials on ways to Create a PivotTable.

Create a PivotTable
1. Prepare your data to create a PivotTable by making sure all columns are named and that the data only has a single-row heading.
2. Select the cells you want to create a PivotTable. The selected cells will be the Data Source.
3. Inthe Insert tab and Tables group, click on PivotTable.
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Figure 3. Tables group of the Insert Tab in Excel

4. The Create PivotTable dialog box will appear. In Table/Range, verify the cell range. Under Choose where you want the PivotTable report to
be placed, leave it at the default option New Worksheet to place the PivotTable in a new worksheet or choose Existing worksheet then
select the location in an existing worksheet where you want the Pivot Table to appear. Click OK.

Add Fields to PivotTable

To add a field to your PivotTable, you can check the box next to the field name in the PivotTables Fields pane or click on the field name and drag it

to the desired areas (Filters, columns, rows or values). Note: selected fields will be added to the default area and will need to be dragged to the
target area.

PivotTable Fields

Choose fields to add to report:

CourseID
CRMN
Status

Drag fields between areas below:

FILTERS COLUMNS

ROWS % VALUES

Figure 4. PivotTable Fields

Modify Values Field in PivotTable

Depending on the variable type, by default, Excel will sum or count the fields added to values area of PivotTable Fields. However, other
calculations exist such as average, maximum, or minimum.

There are two ways to access other calculation options, first, select a field in the Values area for which you want to change the summary function
of the PivotTable report.

1. click on the small upside-down triangle next to your value and select Value Field Settings or
2. Onthe Analyze tab, in the Active Field group, click Field Settings.
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The Value Field Settings dialog box will appear.

In the dialog box:
o Source Name is the name of the field in the data source.
e Custom Name displays the current name of the field in the PivotTable report. To change the Custom Name, click the text in the box and edit
the name.

In the Summarize Values By tab, in the Summarize value field by box, click the summary function that you want to use.

Source Name: CRN

Custom Mame: |Sum of CRN

Summarize Values By  Show Values 4s

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

Mumber Format Cancel
Figure 5. Value Field Settings dialog box

Summarize values:
e Sum - The sum of the values. This is the default function for numeric values.
e Count - The number of values. The Count summary function works the same as the COUNTA worksheet function. Count is the default
function for values other than numbers.
o Average- The average of the values.
e Max - The largest value.
e Min - The smallest value.
e Product - The product of the values.
o Count Numbers - The number of values that are numbers. This works the same as COUNT worksheet function.
o StDev - An estimate of the standard deviation of a population, where the sample is a subset of the entire population.
o StDevp - The standard deviation of a population, where the population is all of the values to be summarized.
e Var - An estimate of the variance of a population, where the sample is a subset of the entire population.
e Varp - The variance of a population, where the population is all of the values to be summarized.
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For custom calculation
Click the Show Values As tab.
Under Show Values As, click on the calculation you want to perform.

Calculation options:

o No calculation - Turn off custom calculation.

® % of Grand Total - Display a value as a percentage of the grand total of all the values or data points in the report.
e % of Column Total- Display all the values in each column or series as a percentage of the total for the column or series.
® % of Row Total - Display the value in each row or category as a percentage of the total for the row or category.

e % Of - Display a value as a percentage of the value of the Base item in the Base field.

e % of Parent Row Total - Calculate (value for the item) / (value for the parent item on rows).

e % of Parent Column Total - Calculate (value for the item) / (value for the parent item on columns).

e % of Parent Total — Calculate (value for the item) / (value for the parent item of the selected Base field).

¢ Difference From - Display a value as the difference from the value of the Base item in the Base field.

® % Difference From - Display a value as the percentage difference from the value of the Base item in the Base field.
e Running Total in - Display the value for successive items in the Base field as a running total.

® % Running Total in - Display the value as a percentage for successive items in the Base field as a running total.

o Rank smallest to largest - Display the rank of selected values with the smallest item as 1, and each larger value with a higher rank value.

o Rank largest to smallest - Display the rank of selected by with the largest item as 1, and each smaller value with a higher rank value.
e Index -Calculate a value as follows - ((value in cell) x (Grand Total of Grand Totals)) / ((Grand Row Total) x (Grand Column Total))

Format numbers

Click Number Format, and in the Number tab of the Format Cells dialog box, select a number format, and then click OK.

Edit PivotTable Layout
PivotTable comes with two tabs - Analyze and Design.
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Figure 6. Analyze tab of PivotTable layout
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Figure 7. Design tab of PivotTable layout

PivotTable Style Options
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